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[bookmark: _Toc228119355]Design & Developer Handoff Guide
Document version: 1.0    •    Date: 2026-04-26    •    Author: Senior Architect, Acme MuleSoft Architect
Audience: Developer taking over remaining dev work on the Acme OMS/SMC3 rating integrations.
Repos covered:
acme-mule-otp-sys-api  —  System API wrapping Oracle Transportation Manager (OMS)
acme-mule-rating-prc-api  —  Process API for canonical rating envelope orchestration
Scope of this document is the rating integration only (Tracker Lines 9 & 10). Locations, releases, transmissions, ping/heartbeat are intentionally not covered here.
[bookmark: _Toc228119356]Overview
The rating integration moves shipment rate requests and responses between Oracle Transportation Manager (OMS) and SMC3 through two MuleSoft apps:
acme-mule-otp-sys-api  —  exposes simplified REST/JSON for OMS operations and brokers OAuth2 to OMS via Oracle IDCS. Publishes raw OMS XML to Anypoint MQ. Always-XML toward OMS, JSON toward callers.
acme-mule-rating-prc-api  —  consumes raw payloads, transforms them into a canonical {meta,data} envelope, and dispatches them to the right downstream (SMC3 or otp-sys-api). Returns 202 Accepted to callers and never blocks on the downstream call.
The pattern is fire-and-forget pub/sub. The HTTP listener on the prc-api never waits on SMC3 or OMS — it publishes to MQ and returns 202. Two background subscribers (otm-raw-dispatcher and rating-canonical-dispatcher) handle the heavy lifting and routing, driven by the integration field on each MQ message / canonical envelope.
Two integrations are wired today:
Tracker Line 9  —  smc3-rate-request  (OMS → SMC3, dispatch is stubbed pending SMC3 wiring)
Tracker Line 10  —  smc3-rate-response  (SMC3 → OMS via otp-sys-api)
The diagram on the next page shows the full flow.







[bookmark: _Toc228119357]Process Flow Diagram (rating-prc-api)


[bookmark: _Toc228119358]Opening the Projects in Anypoint Studio
Both repos already contain Eclipse / Studio metadata files (.project and .classpath) so that File → Import → Existing Projects into Workspace will recognize them as Mule projects without any manual conversion.
[bookmark: _Toc228119359]Prerequisites
Anypoint Studio 7.18+ (the Mule 4.9 runtime is bundled or downloadable inside Studio).
JDK 17 (Studio → Window → Preferences → Java → Installed JREs).
Maven 3.9+ on PATH (Studio uses its embedded m2e but Maven CLI is needed for mvn deploy).
An Anypoint account (Connected App credentials below) with access to the Acme business group.
[bookmark: _Toc228119360]Import the projects
1. File → Import → General → Existing Projects into Workspace.
2. Browse to the repo root (acme-mule-otp-sys-api or acme-mule-rating-prc-api).
3. Studio detects the .project file, ticks the project, click Finish.
4. Right-click the project → Maven → Update Project (Alt+F5) to refresh dependencies.
5. The first build pulls all mule-plugin JARs from Anypoint Exchange and MuleSoft Releases. Allow ~5 minutes the first time.
[bookmark: _Toc228119361]Maven settings.xml
Studio looks at ~/.m2/settings.xml for repository credentials. The Acme-Exchange entry uses the Connected App pattern:
<server>
  <id>Acme-Exchange</id>
  <username>~~~Client~~~</username>
  <password>fb2060c4a40e41f49f4a2311a0d3b590~?~b0dFFB560A40409Ab533d72aA61B757E</password>
</server>
Replace the values with your own Connected App credentials if you have a personal one. The format is literally clientId~?~clientSecret with the username ~~~Client~~~.
[bookmark: _Toc228119362]Run locally
Right-click the project → Run As → Mule Application. Defaults to port 8081.
Set mule.env=Development in the Run Configuration (Arguments tab) to load src/main/resources/config/Development.yaml.
Set mule.key=4HZ3gVNJ96MPbqWwDpil6g2iZAEfYyqa  (non-prod AES-CBC key, used to decrypt ![...] secrets in YAML).
Hit http://localhost:8081/heartbeat (sys-api) or http://localhost:8081/v1/heartbeat (prc-api).


[bookmark: _Toc228119363]Azure Key Vault Integration
Implemented in acme-mule-otp-sys-api/src/main/mule/azure-config.xml (the prc-api uses an identical block once it's added; for now it relies on inline secure properties).
[bookmark: _Toc228119364]What it does
On startup and every hour the app:
Posts client_credentials grant to Azure AD (login.microsoftonline.com/{tenant}/oauth2/v2.0/token) using a Service Principal whose id/secret live in the encrypted YAML.
Receives an AAD bearer token, stores it in an in-memory Object Store (Azure_Secrets_Store, TTL 2h, max 500 entries).
GETs each named secret from Key Vault (asc-lw-ue2-mul-akv-01.vault.azure.net) and stores its .value in the same store under the secret name.
Repeats the dance for App Configuration (asc-lw-ue2-scms-mul-cfg-01.azconfig.io), filtered by the env label (Dev/Test/QA/Prod), and stores every key/value.
Failures during bootstrap are caught by an on-error-continue so a momentary Azure hiccup never breaks the app start. Subsequent hourly refreshes will pick up rotated secrets.
[bookmark: _Toc228119365]Names the bootstrap pulls today
anypoint-platform-clientId
anypoint-platform-clientSecret
anypoint-mq-clientId
anypoint-mq-clientSecret
appinsights-connectionString
These names are configured in src/main/resources/config/common.yaml under the secrets.* keys. To add a new secret, append the property and the secret name in Key Vault, then add the property reference to the secretKeys list in azure-config.xml :: azure-load-keyvault-secrets.
[bookmark: _Toc228119366]Reading a cached value at runtime
Anywhere in a flow:
<set-variable variableName="secretKey" value="anypoint-mq-clientSecret"/>
<flow-ref name="get-azure-secret"/>
<!-- payload now equals the cached secret value -->
If the value is missing (Key Vault returned 404 or RBAC blocked it), payload will be null and the caller is responsible for a graceful fallback.
[bookmark: _Toc228119367]Azure RBAC required on the Service Principal
Key Vault Secrets User on asc-lw-ue2-mul-akv-01 (non-prod) and the prod KV.
App Configuration Data Reader on asc-lw-ue2-scms-mul-cfg-01 (non-prod) and the prod store.


[bookmark: _Toc228119368]Azure Application Insights Integration
Two pieces are wired:
applicationinsights-runtime-attach 3.7.5 — the JVM agent attaches at startup and auto-instruments JDBC/HTTP/Mule, sending request, dependency, exception, and live-metric telemetry.
applicationinsights-logging-log4j2 2.6.4 — the ApplicationInsightsAppender added to log4j2.xml routes our JSON-formatted log lines through to App Insights as customEvents.
[bookmark: _Toc228119369]log4j2.xml extract
<ApplicationInsightsAppender name="aiAppender">
    <PatternLayout pattern="%msg"/>
</ApplicationInsightsAppender>

<AsyncLogger name="org.mule.extension.jsonlogger" level="INFO" additivity="false">
    <AppenderRef ref="aiAppender"/>
    <AppenderRef ref="Console"/>
    <AppenderRef ref="CLOUDHUB"/>
</AsyncLogger>
PatternLayout is %msg only — no timestamp/thread prefix — because every log line we emit is already a fully-formed JSON object (from json-logger or from a DataWeave-built summary). App Insights then ingests it as a structured customEvents row.
[bookmark: _Toc228119370]Connection string
The connection string for the Application Insights instance is named appinsights-connectionString in Key Vault. The runtime-attach JAR reads it from the APPLICATIONINSIGHTS_CONNECTION_STRING environment variable, which CloudHub sets as a runtime property at deploy time (see deployment-args.json in the workflow).
[bookmark: _Toc228119371]What you'll see in the Azure portal
Application Insights blade → Logs → customEvents will show one row per Final Summary Log line and one row per ERROR JSON.
Application Map shows otm-sys-api and rating-prc-api as separate nodes with arrows representing the dependency calls (HTTP and Anypoint MQ).
Failures blade automatically picks up exceptions even though we suppress stack traces in our own logs — the runtime-attach agent captures them at the JVM level.


[bookmark: _Toc228119372]Final Summary Logging (DataCo pattern)
Every flow in acme-mule-rating-prc-api emits exactly one terminal log line with a single-line JSON payload. This is the row that downstream observability tools key off.
[bookmark: _Toc228119373]Where it lives in the flow
After the success transform that builds the response, immediately before the </flow>:
<ee:transform doc:name="Build Summary">
    <ee:variables>
        <ee:set-variable variableName="logSummary"><![CDATA[%dw 2.0
output application/json
---
{
    api: "acme-mule-rating-prc-api",
    operation: vars.operation,
    integration: vars.integration,
    correlationId: vars.correlationId,
    tracePoint: "END",
    status: "SUCCESS",
    httpStatus: vars.httpStatus default 202,
    durationMs: (now() - vars.startTime) as Number {unit: "milliseconds"},
    summary: vars.operation ++ " | " ++ (vars.httpStatus default "202" as String) ++ " | " ++ ((now() - vars.startTime) as Number {unit: "milliseconds"} as String) ++ "ms"
}]]></ee:set-variable>
    </ee:variables>
</ee:transform>
<logger level="INFO" doc:name="Log Summary" category="acme.rating.prc"
        message="#[vars.logSummary]"/>
[bookmark: _Toc228119374]Required vars to set at the start of every flow
vars.startTime  —  set to now() in the very first processor
vars.operation  —  human-readable label, e.g. "POST /rate-requests"
vars.integration  —  enum value, e.g. "smc3-rate-request" — must match the keys used by the dispatchers
vars.correlationId  —  defaults to the platform correlationId; flows that publish to MQ also pass it as the x-transaction-id message property
[bookmark: _Toc228119375]Why category="acme.rating.prc"
log4j2.xml routes anything in that category through aiAppender + the CloudHub appender. Don't change the category on existing flows or you'll lose App Insights visibility.
[bookmark: _Toc228119376]Step logs (json-logger)
Inside the flow, intermediate STEP/FLOW log lines come from the Acme JSON Logger plugin (mule-plugin acme-mule-common-json-logger). They share the correlationId and produce a separate customEvents row each. Use them at decision points, not after every single processor — too noisy in CloudHub.
<json-logger:logger doc:name="STEP: published to MQ"
    config-ref="JSON_Logger_Config"
    tracePoint="FLOW"
    message='#["raw payload published to " ++ p("anypoint.mq.queue.otm.raw")]'/>


[bookmark: _Toc228119377]Error Handling
Defined in acme-mule-rating-prc-api/src/main/mule/errors.xml. The router and every flow reference <error-handler ref="global-error-handler"/>.
[bookmark: _Toc228119378]Principles
Never leak stack traces. logException="false" on every on-error-propagate, and the log4j pattern is %m%n (no %ex).
Always return the canonical envelope. Even on failure the body is {meta:{...,eventType:"error"}, data:{code,reason,message,errorType}}.
Set vars.httpStatus before flow-ref to build-canonical-error so the HTTP listener returns the correct code (the router maps vars.httpStatus to the response status).
[bookmark: _Toc228119379]Mapping table
	Mule error type(s)
	HTTP status
	Reason phrase

	APIKIT:BAD_REQUEST, HTTP:BAD_REQUEST, APIKIT:NOT_ACCEPTABLE, HTTP:PARSING, VALIDATION
	400  —  Bad Request
	

	HTTP:UNAUTHORIZED, HTTP:CLIENT_SECURITY, HTTP:FORBIDDEN, SECURITY
	401  —  Unauthorized
	

	APIKIT:NOT_FOUND, HTTP:NOT_FOUND
	404  —  Not Found
	

	APIKIT:METHOD_NOT_ALLOWED, HTTP:METHOD_NOT_ALLOWED
	405  —  Method Not Allowed
	

	APIKIT:UNSUPPORTED_MEDIA_TYPE, HTTP:UNSUPPORTED_MEDIA_TYPE
	415  —  Unsupported Media Type
	

	HTTP:CONNECTIVITY, HTTP:RETRY_EXHAUSTED, HTTP:SERVICE_UNAVAILABLE
	503  —  Service Unavailable
	

	HTTP:TIMEOUT
	598  —  Process API Dependent Service Timeout
	

	ANY (catch-all)
	500  —  Internal Server Error
	





[bookmark: _Toc228119380]The build-canonical-error sub-flow
Builds the error envelope and emits one ERROR JSON log line:
{
  level: "ERROR",
  api: "acme-mule-rating-prc-api",
  operation: vars.operation default "unknown",
  integration: vars.integration default "unknown",
  correlationId: (vars.correlationId default correlationId) as String,
  httpStatus: vars.httpStatus default 500,
  errorType: error.errorType.identifier default "UNKNOWN",
  message: error.description default "An unexpected error occurred.",
  tracePoint: "EXCEPTION"
}
Note the message field uses error.description, not error.cause.message — .description is already a sanitized human-readable string and is safe to expose to callers.
[bookmark: _Toc228119381]What is intentionally NOT here
No retry/circuit-breaker. Retries belong on the dispatcher subscriber side (Anypoint MQ already redelivers up to 5 times before DLQ) and on the outbound HTTP requester. Adding retry inside a 202 listener would defeat fire-and-forget.
No async error queue. Failures inside the dispatcher subscribers go to the queue's paired DLQ (otm-raw-dlq, rating-canonical-dlq). Monitor those in Anypoint MQ → Destinations.


[bookmark: _Toc228119382]Testing the Rates Integration with Postman
Collection lives at acme-mule-postman-collection/Acme-OTP-APIs.postman_collection.json. After importing, set the DEV environment variables:
sys_api_base_dev = https://<sandbox-host>.cloudhub.io
prc_api_base_dev = https://<sandbox-host>.cloudhub.io/v1
client_id        = cd6d06552b0d484a90daa58f439409aa
client_secret    = dE8407A24a354cd0b94B56f282d3fA9D
client_id and client_secret are the API Manager DEV environment credentials — every request in the collection sends them as headers (this is what unlocks the auto-discovered API contract).
[bookmark: _Toc228119383]Smoke test order
Run requests in this order. Each one already has a real captured DEV response example attached in the collection — click "Examples (1)" in Postman to compare your live response against the recorded one.
GET {{prc_api_base_dev}}/heartbeat  →  200 with {status:"UP", apiName, apiVersion}
GET {{prc_api_base_dev}}/integrations  →  200 with the registry of wired integrations (smc3-rate-request, smc3-rate-response, ere-rate-request)
POST {{prc_api_base_dev}}/rate-requests  →  202 canonical ack, message published to otm-raw-queue
POST {{prc_api_base_dev}}/rate-responses  →  202 canonical ack, JSON published to otm-raw-queue, then routed to otp-sys-api which forwards to OMS
POST {{sys_api_base_dev}}/rate-requests  →  202, same path through the OMS ERE (External Rating Engine) entry point. Body is OMS SOAP/XML.
[bookmark: _Toc228119384]Sample bodies
POST /rate-requests on prc-api (canonical trigger):
{
  "shipmentGid": "Acme.SHP-(415) 215-3601",
  "domainName": "Acme",
  "servprovGid": "Acme.SMC3"
}


POST /rate-responses on prc-api (canonical SMC3 → OMS):
{
  "meta": {
    "transactionId": "test-txn-001",
    "integration": "smc3-rate-response",
    "direction": "SMC3->OMS",
    "source": "SMC3",
    "target": "OMS",
    "eventType": "rate-response",
    "schemaVersion": "1.0",
    "producer": "acme-mule-rating-prc-api",
    "timestamp": "2026-04-26T22:00:00.000Z"
  },
  "data": {
    "rate": {
      "quoteId": "Q-TEST-001",
      "shipmentRef": "Acme.SHP-(415) 215-3601",
      "scac": "FXFE",
      "totalCharge": 482.77,
      "currency": "USD",
      "transitDays": 3,
      "effectiveDate": "2026-04-25",
      "expirationDate": "2026-05-02",
      "charges": [
        {"code": "LIN", "description": "Linehaul", "amount": 410.00},
        {"code": "FSC", "description": "Fuel Surcharge", "amount": 72.77}
      ]
    }
  }
}
[bookmark: _Toc228119385]Verifying the pub/sub side
Anypoint Platform → MQ → us-east-1 → destinations → otm-raw-queue → Statistics: count of messages should increment by 1 per POST.
rating-canonical-queue should also tick up by 1 — if it doesn't, the otm-raw-dispatcher subscriber didn't pick the message up; check correlation between the integration property on the raw queue and a corresponding when/ branch in otm-raw-dispatcher.xml.
If a queue depth keeps climbing, confirm the prc-api app is APPLIED in CloudHub (not APPLYING / FAILED).
[bookmark: _Toc228119386]Negative tests (verify graceful errors)
GET {{prc_api_base_dev}}/wrong-path  →  404 with canonical envelope, eventType="error", code=404, no stack trace
DELETE {{prc_api_base_dev}}/rate-requests  →  405 Method Not Allowed, canonical envelope
POST {{prc_api_base_dev}}/rate-requests with Content-Type: text/plain  →  415 Unsupported Media Type
Strip the client_id header  →  401 from API Manager (handled before the app's error handler runs)


[bookmark: _Toc228119387]Open Items for the Incoming Developer
smc3-rate-request.dispatch sub-flow is a stub. Replace the logger with an http:request to the SMC3 rating endpoint once SMC3 credentials are loaded into Key Vault.
Sibling Process APIs (shipment, tendering, settlement, masterdata) only have RAML zips published — GitHub repos and Mule scaffolds are still TODO. Follow the rating-prc-api layout when scaffolding.
Post-deploy public-access PATCH (CloudHub Application Manager API) currently runs manually after each mvn deploy. Codify it in the cd-deploy.yml workflow.
Heartbeat health check on private spaces still relies on the Anypoint Application Manager status — add to cd-deploy.yml.
Tests — zero MUnit coverage today. At minimum, add MUnit suites for build-canonical-error (every error type), the otm-raw-dispatcher routing choice block, and the SMC3 rate-response transform DataWeave.


[bookmark: _Toc228119388]References
Repo: acme-mule-otp-sys-api (System API)  —  github.com/Acme Corp/mulesoft-acme-mule-otp-sys-api
Repo: acme-mule-rating-prc-api (Process API)  —  github.com/Acme Corp/mulesoft-acme-rating-prc-api  (creation pending Morgan)
RAML: documents/acme-raml-rating-prc-api-1.0.0.zip and documents/acme-raml-otp-sys-api-1.0.1.zip
Postman: acme-mule-postman-collection/Acme-OTP-APIs.postman_collection.json
Mapping specs: documents/otm/IMS_OTM_to_SMC3_RateRequest.xlsx (Line 9), documents/otm/IMS_SMC3_to_OTM_RateResponse.xlsx (Line 10)
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